
Unity Plugin
Integrate advanced conversational AI to create intelligent, interactive NPCs for your

games.

Convai's Unity SDK provides you with all the tools you need to integrate

conversational AI into your Unity projects. Convai offers specialized NLP-based

services to build intelligent NPCs for your games and virtual worlds. Our platform is

designed to seamlessly integrate with your game development workflow, enhancing

the interactivity and depth of your virtual environments.

Download the Convai Unity SDK from Unity Asset Store

This is the Core version of the plugin. It has a sample scene for anyone to get

started. This version of the plugin only contains the basic Convai scripts and

Character Downloader.

Visit convai.com for more information and support.

Conversational AI: Leverage advanced NLP capabilities to create NPCs that can

understand and respond to player input in natural, engaging ways.

Intelligent NPCs: Build characters with dynamic dialogue and behaviors that

adapt to player actions and the game world.

Easy Integration: Our SDK is designed for quick and simple integration with your

Unity projects, allowing you to focus on creating compelling gameplay

experiences.

Cross-Engine Support: In addition to Unity, Convai supports other popular game

engines, ensuring broad compatibility and flexibility for your development needs.

Overview

Key Features
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Unity Plugin Quick Setup Video

(OLD) Create AI Characters in Unity | Convai Plugin Setup Tutorial [P(OLD) Create AI Characters in Unity | Convai Plugin Setup Tutorial [P……

Quick Setup Tutorial
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Pre-Requisites
Review the prerequisites for integrating Convai with Unity. Ensure seamless setup

and functionality.

The Convai Unity SDK supports a minimum of Unity 2022.3.x or later. 

You should have Git installed locally on your system.

Before integrating the Convai SDK, you should be comfortable with the following:

1. Importing Packages: Know how to import external packages into a Unity

project.

2. Unity Editor: Be proficient in navigating the Unity Editor interface.

3. Animations: Understand how to add and handle animations for assets.

4. Programming in C#: Have a basic experience programming Unity scripts in C#.

5. Script Integration: Be capable of adding scripts to a game object.

6. Building and Deployment: Know how to build and deploy an application to your

chosen platform.

Having these skills will ensure a smooth integration and optimal use of the Convai

Unity SDK in your projects.

Unity Version

Skills and Knowledge
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Compatibility
Check Convai plugin compatibility with Unity. Ensure smooth integration with your

development tools.

The minimum supported Unity version is 2022.3.x. Earlier versions may not be

compatible.

Tested Platform Scripting Backend API Level

Windows MONO .NET Standard 2.1 or .NET 4.x+

MacOS MONO .NET Standard 2.1 or .NET 4.x+

Android IL2CPP .NET 4.x+

iOS IL2CPP .NET 4.x+

WebGL MONO .NET Standard 2.1 or .NET 4.x+

Oculus IL2CPP .NET 4.x+

Unity Version API Level

2022.3 or Higher .NET Standard 2.1 or .NET Framework

Unity Version

Supported Platforms

Disabling Assembly Validation
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Downloads
Download Convai tools for Unity. Access the latest plugins and updates for AI

integration.

There are some limitations for WebGL version of the plugin, to learn about it, please go

to Limitations of WebGL Plugin

Version Features Download Link

Unity Verified Solution

This is the Long-Term Support version

of our core version. It contains

all the necessary tools for adding

conversational AI to your characters.

Download

here.

WebGL

This plugin version should be used

if you need to build for WebGL.

Please ensure that Git is installed on

your computer prior to proceeding.

Download

here.
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Limitations of WebGL Plugin
Understand the limitations of the WebGL plugin for Unity with Convai. Optimize your

development.

iOS browsers impose strict limitations on the size of WebGL builds. These

constraints are primarily due to:

Memory Limits: iOS devices have limited available memory for web applications,

which can affect the performance and feasibility of running large WebGL builds.

Browser Storage Quotas: Safari and other iOS browsers restrict the amount of

data that can be stored locally. This includes caching and Indexed DB, which are

often used to store assets for WebGL builds.

Maximum Downloadable Asset Size: iOS browsers may restrict the size of

individual downloadable assets. Large assets might fail to load, causing the

application to break.

Total Build Size: The total size of all assets combined should ideally be kept

under 50-100 MB for smooth performance. Exceeding this limit can lead to

crashes or extremely slow loading times.

Memory Usage: iOS devices typically have less RAM available compared to

desktop environments. High memory usage by WebGL builds can result in

frequent browser crashes.

Safari: The default browser on iOS, Safari, is generally the best option for WebGL

builds, but it still has significant limitations compared to other desktop browsers.

Size Constraints

Key Limitations

Browser Compatibility
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Setting Up Unity Plugin
Follow these instructions to setup the Unity Plugin into your project.

The file structure belongs to the Core version of the plugin downloaded from the

documentation.

In the Menu Bar, go the Convai > API Key Setup.

Go to convai.com, and sign in to your Convai account. Signing in will redirect you to

the Dashboard. From the dashboard, grab your API key.

Setting up Unity Plugin
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Enter the API Key and click begin.

This will create an APIKey asset in the resources folder. This contains your API Key. 

Open the demo scene by going to Convai > Demo > Scenes > Full Features
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Click the Convai NPC Amelia and add the Character ID (or you can keep the default

character ID). You can get the character ID for your custom character from this

page Create Character. Now you can converse with the character. The script is set

up so that you have to go near the character for them to hear you.

Now you can test out the Convai Demo Scene and talk to the character present

there. Her name is Amelia and she loves hiking!
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You can open the Convai NPC Script to replicate or build on the script to create new

NPCs.

Try to extend the ConvaiNPC.cs script instead of directly modifying it to maintain

compatibility with other scripts
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Troubleshooting Guide
Troubleshoot common issues with Convai's Unity plugin. Get solutions for seamless

AI integration.

A. Please check if there are any errors in the console. Unity needs to be able to

compile all the scripts to be able to display any custom editor menu options.

Resolving all the console errors will fix this issue. 

A. Primarily, two issues cause errors in the console that can stem from the Convai

Unity Plugin. You can use the links below to fix them quickly. 

1. Disable Assembly Validation

2. Missing Newtonsoft Json

A. This may indicate issues with the microphone. Please ensure that the

microphone is connected correctly. You also need to ensure that the applications

have permission to access the menu.

Microphone Permission Issues

Common Issues (FAQ)

Q. I cannot see the Convai menu.

Q. There are a lot of errors on my console.

Q. I am talking to the character, but I cannot see the user
transcript and the character does not seem to be
coherently responding to what I am saying.
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A. The animation avatar that we are using might be incompatible with the character

mesh. Fixing that can solve the issue.

Default Animations Incompatibility

A. If you are using Unity 2021, unexpected prefab variant issues may arise. This is

because Unity Mobile Transcript UIs are variants of the main transcript UI prefab.

With changes in the Prefab system in Unity 2022, it works correctly in Unity 2022. If

you are using Unity 2021, you may encounter issues with prefabs. You can remove

the redundant Settings Panel Button to address this problem.

A: The animations that we are using may be modifying facial animations. Editing the

animations to remove facial animations should fix any issues related to lipsync.

Animations have Facial Blendshapes

A: The script also needs the avatar to not be mapped to the jaw bone to be

manipulate the jaw bones itself. 

Jaw Bone in Avatar is not Free

Q. The animations for my characters are looking very
weird.

Q. There are two Settings Panel Buttons in Mobile
Transcript UI.

Q: The lipsync is very faint or not visible.

Q: I'm facing security permission issues using the 
grpc_csharp_ext.bundle  DLL inside the Unity Editor on
MacOS
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A: macOS's strict security measures can block certain external unsigned DLLs. To

address this, you can manually allow the DLL in "Security & Privacy" settings,

modify Gatekeeper's settings through Terminal, ensure correct file permissions for

the DLL, check its settings in Unity, and update the Mac Configuration in Unity's

Player Settings

macOS Permission Issues

A: The issue is rooted in the grpc_csharp_ext.bundle  used in Unity for

networking. This DLL has separate versions optimized for Intel and Apple Silicon

architectures. When trying to create a Universal build that serves both, compatibility

problems arise, especially on Intel Macs. Presently, the best solution is to use

Standalone build settings specific to each architecture.

Building for macOS Universal apps

Follow this Table to navigate to our most common errors.

Q: I'm not able to talk to my character after building my
Unity project for macOS (Intel64+Apple Silicon builds),
especially on Intel Macs

Error Index
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Name Sample Error Reason for Error

Enabled Assembly

Validation

Unity, by default,

checks for exact

version numbers for

the included

assemblies. For our

plugin, this is not

necessary, since we

use the latest

libraries.

Disable

Assembly

Validation

Missing

NewtonSoft Json

Our plugin needs

Newtonsoft Json as

a dependency. It is

often present as part

of Unity but

occasionally, it can

be missing. 

Missing

Newtonsoft

Json

Assembly 
'Assets/Convai
/Plugins/Grpc.
Core.Api/lib/n
et45/Grpc.Core
.Api.dll' will 
not be loaded 
due to errors: 
Grpc.Core.Api 
references 
strong named 
System.Memory 
Assembly 
references: 
4.0.1.1 Found 
in project: 
4.0.1.2.

Assets\Convai\
Plugins\GLTFUt
ility\Scripts\
Spec\GLTFPrimi
tive.cs(8,4): 
error CS0246: 
The type or 
namespace name 
'JsonPropertyA
ttribute' 
could not be 
found (are you 
missing a 
using 
directive or 
an assembly 
reference?)
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Name Sample Error Reason for Error

Missing

Animation Rigging

We use the

Animation Rigging

package for Eye and

Neck tracking. If

Unity does not

automatically add it,

we need to add it

manually from the

package manager.

Microphone

Permission Issues

The microphone icon

lights up but there is

no user transcript in

the chat UI. The

character seemingly

not replying to what

the user is saying.

The plugin requires

microphone

access which is

sometimes not

enabled by default.

Microphone

Permission

Issues

Default Animations

Incompatibility

The default animations

that ship with

the plugin seems

broken. The hands

seem to intersect

with the body.

The animation avatar

is incompatible with

the character mesh.

Default

Animations

Incompatibilit

y

Animations

have Facial

Blendshapes

The Lip-sync from

characters are

either not visible

or are very faint.

Some types of

animations control

facial blendshapes.

These animations

prevent the lip-sync

scripts to properly

edit the facial

blendshapes.

Animations

have Facial

Blendshapes

Jaw Bone in

Avatar is not Free

The Lip-sync from

characters are

The animation avatar

for the character

Jaw Bone

in Avatar

Assets\Convai\
Scripts\Utils\
HeadMovement.c
s (2,30): 
error CS0234: 
The type or 
namespace name 
'Rigging' does 
not exist in 
the namespace 
'UnityEngine.A
nimations' 
(are you 
missing an 
assembly 
reference?)
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For any other issues, please feel free to reach out to support@convai.com or on our

Discord Server.

Name Sample Error Reason for Error

either not visible or are

very faint.

may be using the

Jaw Bone. If we set

the mapping free to

none, the script will

be able to

manipulate the jaw

bone freely. 

is not Free

Mac Security

Permission Issue

Security Permission

Issues with

grpc_csharp_ext.bun
dle

DLL in Unity

on MacOS.

MacOS's security

protocols can

prevent certain

unsigned external

DLLs, like 

grpc_csharp_ext.b
undle

, from functioning

correctly in Unity.

macOS

Permission

Issues

Microphone

Permission Issue

with Universal

Builds on Intel

Macs in Unity

No Microphone

access request

pops up

Incompatibility

between Intel and

Apple Silicon

versions of 

grpc_csharp_ext.b
undle

when attempting a

Building

for macOS

Universal

apps
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Disable Assembly Validation
If you ever get an error that looks like this, disable the Assemble Version Validation

in Project Settings  > Player  > Other Settings .

Ensure that Assembly Validation is disabled in Project Settings  > Player  > 

Other Settings .

Restart the Unity project after unchecking the box should fix the issue.

Assembly 
'Assets/Convai/Plugins/Grpc.Core.Api/lib/net45/Grpc.Core.Api.dll' will 
not be loaded due to errors: 
Grpc.Core.Api references strong named System.Memory Assembly references: 
4.0.1.1 Found in project: 4.0.1.2.
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Missing Newtonsoft Json
Fix missing Newtonsoft JSON issues in Unity with Convai. Resolve integration

problems efficiently.

Our plugin has various scripts and dependencies that use Newtonsoft Json. If

Newtonsoft Json is missing from the plugin, it could lead to a large number of

errors as shown below:

Ensure that NewtonSoft.Json is present in your packages. Go to your project folder. 

Then navigate to Packages folder. In the Packages folder. Click on manifest.json. A

json file containing the project dependacies should open up.

Add the Newtonsoft Json Package on top.

    "com.unity.nuget.newtonsoft-json": "3.2.1",
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The final manifest.json should look like this.

{  
    "dependencies": {
        "com.unity.nuget.newtonsoft-json": "3.2.1", 
        "com.unity.animation.rigging": "1.1.1",
        "com.unity.ide.rider": "3.0.16",
        "com.unity.ide.visualstudio": "2.0.16",
        "com.unity.ide.vscode": "1.2.5",
        "com.unity.test-framework": "1.1.33",
        "com.unity.textmeshpro": "3.0.6",
        "com.unity.timeline": "1.6.4",
        .
        .
        .
    }
}
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Microphone Permission Issues
Resolve microphone permission issues in Unity with Convai. Ensure smooth voice

interactions.

If you see the microphone indicator turning on in the top left corner but no user

transcript in the chat UI and the character's response doesn't seem coherent to

what you said, then it is likely that the game or Unity is not accessing the correct

microphone or does not have sufficient microphone privilege. To fix this, please

follow along.

The microphone icon on the top left is on, indicating that mic is listening
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Select proper microphone device from the drop down list
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Click on Record to make sure microphone is recording properly
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Press Stop to listen to the audio recorded through the selected mic

Check Notification System page to learn
more about various issues related to
microphone
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Default Animations Incompatibility
Fix default animation incompatibilities in Unity with Convai. Ensure smooth AI

character animations.

If the default animations that ship with the animator look bugged such that the hand

seems to intersect with the body, it could indicate an issue with the wrong

animation avatar being selected. 

You can easily fix that by heading to the character's animator component and

assigning the correct animator to the Avatar field.

For male avatars
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The correct animation will look something like this. The hands should not intersect

the body.

For female avatars
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Animations have Facial Blendshapes
Resolve facial blendshape issues in Unity animations with Convai. Improve

character realism.

If the Lip-sync from characters are either not visible or are very faint, if could be a

result of character's animations overriding the blendshape changes made by the

script. We recommend deleting the relevant components in the animation

dopesheet.

The blendshapes in the CC_Base_Body's Skinned Mesh Renderer. We shall delete these.
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Jaw Bone in Avatar is not Free
Fix jaw bone issues in Unity avatars with Convai. Ensure smooth lip sync and

animations.

If the Lip Sync does not seem to cause any facial animations, even after removing

all blendshapes from animations, then the following steps should help resolve the

issue.

This is a known issue in Reallusion CC4 characters.

Select the Character and head to the Animator component.

Click the Avatar Field once to select the character's avatar in the Project window.

Select the Avatar and click Configure Avatar.
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Select the Head option in the Mapping tab.
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Select the Jaw Mapping and set it to None.
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Finally scroll down and click Apply.
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This will free the avatar's jaw mapping and allow the script to manipulate the Jaw

bones.
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macOS Permission Issues
macOS security permission issue with custom DLLs in Unity and Mac Configuration

in build settings

Using external DLLs in Unity on MacOS can lead to security permission issues due

to Apple's strict security measures. Here's a step-by-step guide to resolving this

common problem.

1. Verify the Problem:

2. Manually Allow Blocked DLLs:

Open System Preferences on your Mac.

Navigate to "Security & Privacy".

Allowing the grpc_csharp_ext.bundle dll file
in macOS

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 88/529



Under the "Security" tab, you might see a message at the bottom about the

DLL being blocked. Click "Allow Anyway" or "Open Anyway" and enter

password if asked.
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3. Modify Gatekeeper settings: MacOS's Gatekeeper can prevent unidentified

developers' software from running. To allow the DLL:

4. Check File Permissions: Ensure the DLL has the correct file permissions.

5. Review Unity's Plugin Settings:

Open the Terminal (found in Applications > Utilities).

Type sudo spctl --master-disable  and press Enter.

This command will allow apps to be downloaded from anywhere.

Now, try running the Unity project again.

After you're done, you should re-enable Gatekeeper with 

sudo spctl --master-enable   to avoid any malware.

In Finder, right-click (or control-click) on the DLL file and choose "Get Info".

Under “Sharing & Permissions”, ensure that your user account has "Read &

Write" permissions.

In the Unity editor, select the DLL in the Project view.
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In the Inspector window, make sure the appropriate platform (in this case,

Mac OS X) and architecture (Apple Silicon, Intel-64) is selected for the DLL.

Ensure that the "Load on Startup" and other pertinent options are checked

(should be enabled by default)

Update Mac Configuration:

In Unity, navigate to Edit > Project Settings > Player .

Scroll down and click on Other Settings

Scroll down again to find Mac Configuration section

Mac Configuration in Player Settings during
build
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Update the Mac Configuration section (follow the below Screenshot)
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Creating a Convai Powered
Scene from Template
This guide will help you make a scene in unity with Convai Essentials already

present in it. It will help you to get started with our plugin very fast.

You can open the new scene window by two ways, first by pressing Ctrl + N   for

windows or CMD + N  for Mac on your keyboard, second way is to navigate to File -

> New Scene

There will be many scene templates depending upon your project, but in this guide,

we are interested in Convai Scene Template so select that and click on Create

Screenshot showing process of opening up New Scene Window in Unity

Step 1) Open the New Scene window

Step 2) Select Convai Scene Template
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button.

You can now save the newly created scene in the project at your desired location

by either pressing Ctrl + S  on Windows or CMD + S  on Mac. Another method is

to navigate to File -> Save Scene

Screenshot showing how to create a scene from convai scene template

Step 3) Save Created Scene
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This is open the Save Scene Window, choose your desired location, for this demo

we will save it inside Demo folder, but you can save it anywhere in the assets

directory.

Give your scene a name and then click on Save Scene button

Screenshot showing how to save the scene
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Now you can import your Convai Character or your Custom Characters by following

our complete guide on it

Importing RPM Characters

Importing Custom Characters

Screenshot showing save location of the new Convai powered scene
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Importing RPM Characters
Follow these instructions to bring a character from the Convai Playground into your

Unity Project.

This is how you can import characters from the Convai Playground into your Unity

Project.

In the Menu Bar, go the Convai > Character Importer.

Enter the Character ID and click Import.

Import RPM characters from the Convai
Playground
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If you are unsure how to get the character ID, click the "How do I create a

character?".

You can get the character ID from the Character Description.

Enter the character ID and click Import.
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The downloading will take a while. On successful download, you will see the

character in the scene with the same GameObject as the character ID. 
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This character will automatically be set up with the basic Convai Setup including the

ConvaiNPC Script and Out-Of-Box Animations. 
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If you are facing issues with the animations in your imported character, make sure

to change the animation type of Ellen@IdleNew  and Ellen@TalkingNew

Animations in the Assets/Convai/Animations  folder to Humanoid .
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Now you are ready to set up the character with transcriptions. 

Change the animation type to 'Humanoid' and click 'Apply'.
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Importing Custom Characters
Follow these instructions to set up your imported character with Custom Model with

Convai.

To import your custom characters into your Convai-powered Unity project, you will

first need to bring your model into your project. The model needs at least two

animations: one for talking and one for Idle.

When you want to set up your custom character with Convai, you will need your

character model and two animations: Idle and Talking. 

Create an animator controller with the two animations that looks like this. You

should also add a 'Talk' Boolean to ensure that you can trigger the animation. Here

is a YouTube tutorial on how to set up an animator controller. This is the bare

minimum animator setup that you need to do. 

The animator controller should look like this. This is the in-box NPC Animator. 

Prerequisites

Step 1: Add Animator to your custom character
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Select your character from the Hierarchy and Add Animator Component

Convai Plugin ships with two pre-made animation controller, you can choose these

controllers or can assign your custom controller, whatever fits your need. For this

demo we are going with Feminine NPC Animator

Screenshot showing newly added Animator Component

Screenshot showing selection of Animation Controller
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With your custom character selected, add a Collision shape of your choice, for this

demo we are going with a Capsule Collider

We will make this Collider a trigger, for this we will enable the Is Trigger  option in

the inspector panel

We will adjust the Center, Radius and Height of the collider such that it fits our

character

Screenshot showing newly added Capsule Collider

Screenshot showing enable of Is Trigger option

Step 2: Adding a Trigger Volume
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With your Custom Character Selection add ConvaiNPC component. By doing so,

your Game objectgame should look like this:

We assume that nothing other than pre-instructed components were added by you;

your Game Object component list may be different

Step 3: Add ConvaiNPC Component
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Copy your character's ID and name from Convai Playground and paste them here.

We will assign Convai Character  layer to your Custom Character Game Object 

Screenshot showing newly added ConvaiNPC Component

Screenshot showing filled-in character information.

Step 4: Setup a: game object for Convai Character
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Now your Custom Character is all set to work with Convai Plugin

Screenshot showing selection of Convai Character
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Adding Actions to your Character
Follow these instructions to enable actions for your Convai-powered characters.

1. Select the Convai NPC character from the hierarchy.

2. Scroll down to the ConvaiNPC script attached to your character.

3. Click the "Add Component" button.

4. Use the checkbox to add the action script to the NPC Actions.

5. Click "Apply Changes" to confirm.

Setting Up Action Configurations

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 109/529

Convai offers predefined actions for a quick start.

1. Click the "+" button to add a new action.

2. From the dropdown menu, select "Move To."

Pre-defined Actions
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3. Enter the action name as "Move To" (the name doesn't have to match the action

choice name).

4. Leave the Animation Name field empty for now.

Repeat these steps to add more actions like "Pickup" and "Drop" etc.

1. Add any object into the scene—a sphere, a cube, a rock, etc.—that can be

interacted with

2. Resize and place the object in your scene.

Adding an Object in the Scene

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 111/529

Create an empty GameObject and name it "Convai Interactables."

Attach the Convai Interactables Data script to this GameObject.

Add characters and objects to the script by clicking the "+" button and attaching

the corresponding GameObjects.

Convai Interactables Setup

Adding the Convai Interactables Data Script
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To ensure your NPCs can navigate the scene:

1. Bake a NavMesh for your scene if you haven't already:

2. Ensure that the NPC character has a NavMeshAgent component:

Add the "There" object in Objects list, so that we can use the Dynamic Move

Target indicator.

Add the Dynamic Move Target Indicator and setup NavMesh agent to you NPC.

Go to Window > AI > Navigation.

In the Navigation window, under the Bake tab, adjust the settings as needed.

Click "Bake" to generate the NavMesh.

If not already attached, click "Add Component" and search for 

NavMeshAgent.

Adjust the Agent Radius, Speed, and other parameters according to your

NPC's requirements.

Setting Up NavMesh
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To visually indicate where your NPC will move:

Create a new empty GameObject in the scene and name it accordingly or use

the pre-made prefab named Dynamic Move Target Indicator.

Link this Move Target Indicator to your NPC's action script so it updates

dynamically when you point the cursor to the ground and ask the NPC to move

to "There".

Adding a Dynamic Move Target Indicator
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1. Click "Play" to start the scene.

2. Ask the NPC, "Bring me the Box." 

3. If setup properly, the NPC should walk upto the box and bring it to you

This feature is currently experimental and can misbehave. Feel free to try it out and

leave us any feedback.

Make your NPC perform custom actions like dancing.

Test the Setup

Adding Custom Actions to Your Unity NPC in
Convai

Introduction
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1. Locate the dance animation file within our plugin.

2. Incorporate this animation into your NPC's actions.

1. Open the Animator Controller from the Inspector window.

2. Drag and drop the dance animation onto the controller, creating a new node

named "Dancing."

1. Go to the Action Handler Script attached to your Convai NPC.

Action that Only Requires an Animation

Setting Up the Animator Controller

Adding custom Animation Action
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2. Add a new action named "Dancing." 

3. In the Animation Name field, enter "Dancing" (it must exactly match the

Animator Controller node name).

4. Leave the enum as "None."

1. Click "Play" to start the scene.

2. Instruct the NPC, "Show me a dance move," and the NPC should start dancing.

Adding advanced custom actions, such as a throw action, to your NPC.

1. Grab a throw animation from Mixamo or anywhere you like.

Testing the Custom Action

Creating Complex Custom Actions in Unity
with Convai: Throwing a Rock

Introduction

Animation Requirement
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2. Import it into Unity.

1. Drag and drop the throw animation onto the controller, creating a new node

named "Throwing." (Follow steps in #action-that-only-requires-an-animation)

1. Add the "Throw" enum to the script.

2. In the "Do Action" function, add a switch case for the throw action. 

Setting Up the Animator Controller

Action Handler Script Setup
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3. Define the "Throw()" function. 

1. Add a new action named "Throw" and select the "Throw" enum. 

2. Leave the animation name field empty. 

Adding the Throw Action
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1. Add any rock prefab into the scene.

2. Add the rock to the Convai Interactable Data script.

1. Add a stage/new location in the ground of the scene.

2. Add that new location game object in the Convai Interactable Data.

Adding the Object (Rock) to the Convai Interactables
Data script

Adding a location to Convai Interactables Data script
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1. Click "Play" to start the scene.

2. Instruct the NPC, "Pick up the rock and throw it from the stage."

3. If everything is set up properly, the NPC should pick up the rock and throw it

from the stage. 

Testing the Complex Action
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Adding Lip-Sync to your Character
Learn to add lip sync to your Unity characters using Convai. Improve realism and

interactivity.

Convai sends Visemes or Blend Shape Frame from back-end depending upon the

face model developer chooses to use and when return Convai SDK out of the box

extracts and parses it and provides it to the Convai LipSync Component , after

which the component relies of the SkinMeshRen derer 's Blendshape Effectors

and Bone Effectors  to give Convai powered NPC's realistic lipsync.

This is where developer will tell the Convai SDK, which index of Blendshape Array

will be effector how much from which value. To better explain its working lets

understand it with a diagram.

Here, its saying that whatever value is coming from the server will affect

Blendshape at 116th index by 0.2 multiplier and Blendshape at 114th index by 0.5

multiplier. The engine representation of this would look something like this.

Lip Sync System

Components of LipSync System

Viseme Effector List
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So, you can make you own Effector list or use one of the many that we ship in the

SDK.

How to Create your own Viseme Effector List

Right click inside project panel and head over to 

Create > Convai > Expression > Viseme Skin Effector  which will create a 

Viseme Effector List Scriptable Object and now you can define your own values

This is where developer will tell the Convai SDK, how much each value coming from

server will affect the rotation of the bone. To better explain its working lets

understand it with a diagram. 

Viseme Bone Effector List
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Here, bone's rotation will be effect by the values coming from server multiplied by

the values in effects. Example, for TH the value will affect bone's rotation by 0.2

multiplier and etc. The engine representation of this would look something like this.
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So, you can make you own Bone Effector list or use one of the many that we ship in

the SDK.

We use this formula to calucate the roatation

How to Create your own Viseme Bone Effector List

Right click inside project panel and head over to 

Create > Convai > Expression > Viseme Bone Effector  which will create a 

Viseme Bone Effector List Scriptable Object and now you can define your own

values.

When you attach this component to your Convai Character, you will see something

like this.  

UpdateJawBoneRotation(
new Vector3(
        0.0f, 
        0.0f, 
        -90.0f - CalculateBoneEffect(FacialExpressionData.JawBoneEffector
    )
);
UpdateTongueBoneRotation(
new Vector3(
        0.0f,
        0.0f,
        CalculateBoneEffect(FacialExpressionData.TongueBoneEffector) * 80f
    )
);

Convai Lipsync Component
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Let's learn what these learns are

1. Facial Expression Data

1. Head | Teeth | Tongue

1. Renderer: Skin Mesh Renderer which correspond to that specified part of

the body

2. Viseme Effectors List: How the SkinMeshRenderer's Blendshape will be

affected by values coming from server.

2. Jaw | Tongue Bone Effector

1. How much Bone's rotation will be affected by values coming from server.

3. Jaw | Tongue Bone

1. Reference to the bone which control jaw and tongue respectively

2. Weight Blending Power

1. Percentage to interpolate between two frames in late update.

3. Character Emotions

1. Learn More about Character Emotions here

Steps to add Lipsync to your Convai Character
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1. Select you Convai Powered Character in the hierarchy.

2. In the inspector panel search for ConvaiNPC component, there you will see

Add Component Button.

3. Click on it and select Convai Lipsync Component and click on apply

1. Select you Convai Powered Character in the hierarchy.

2. Click on Add Component

3. Search for Convai Lipsync

4. Select Convai Lipsync component

Using Convai Add Component Button

Using Unity Add Component Button
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Now you can configure the Component according to your custom configuration or

use one of the many Presets Convai ships with the SDK

Now your lipsync component would be ready to use in your application.
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Adding Narrative Design
to your Character
Follow this guide to incorporate Narrative Design into your Convai-powered

characters. Follow this step-by-step tutorial, open your project, and let's begin!

For this demo, we are using Seraphine Whisperwind , you can select whatever

character you want to enable Narrative Design.

Select the Narrative Design option from the side panel and create your narrative

design

Screenshot showing selection of character in Convai Playground

Convai Playground

Step 1: Select your Character in which you want to
enable Narrative Design

Step 2: Open Narrative Design in Convai Playground
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For more information how to create narrative design in the Convai Playground please

refer to the following YouTube video series

Screenshot showing Icon of Narrative Design
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For this sample we have created the following Narrative design

Video series showing how to create Narrative Design

Narrative Design - Narration Design FlowNarrative Design - Narration Design Flow
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You are all set to bring your character from Convai Playground to Unity, let's hope

over to Unity to continue the guide

Unity Setup

Step 1: Add the Narrative Design Manager Component

Using Add Components Button in Convai NPC (Recommended Way)

1: Select your Convai Character in the scene and look for ConvaiNPC component in

the inspector panel. Click on Add Components button
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Screenshot showing location of Add Components button in the Convai NPC inspector panel 

Screenshot showing selection of Narrative design option in the Add Component Window

2: Select Narrative Design Manager checkbox and then click on Apply Changes

button

Using Unity Inspector

1:  Select your Convai Character and find Add Component button in the inspector

panel 
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Screenshot showing location of Add Component button in the inspector panel

Screenshot showing which component to select from the search results

2: Search for Narrative Design Manager  in the search box and select it

Step 2: Setup the Narrative Design Component
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After adding the Narrative Design Component, you will be able to be the following

component

This component system assumes that API key is setup correctly, so ensure that API

key is setup correctly otherwise an error will be thrown.

After adding, component will retrieve the sections for the character ID taken from the

ConvaiNPC, please wait for some time depending upon your network speed

The following section events are for character used in demo, and you will see section

events corresponding to your character in which Narrative Design is enabled. 

Expanding the section event, you will see two unity events you can subscribe to,

one is triggered when section starts, and another one is triggered when section

ends

Screenshot showing a sample Narrative Design component

Getting to know the Narrative Design Component
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Section triggers are a way to directly invoke a section in narrative design and can

be used to jump to a different section in your narrative design

Make sure that game object you have decided to be a trigger have a collider attach to

it

Screenshot showing various unity events user can subscribe to

Getting to know about Section Triggers

Step 1: Select the game object you want to make a trigger, in this example we have

selected a simple cube, but it's up to your imagination.
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Screenshot showing a game object with a collider selected

Screenshot showing selection of Narrative Design Trigger

Step 2: Add Narrative design Trigger from Add Component menu by searching for it

Step 3: Make the collider a trigger.
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Now you can select from the "Trigger" dropdown which trigger should be invoked

when player enters this trigger box. 

We have added a way for you to manually invoke this trigger also, you can use 

InvokeSelectedTrigger  function to invoke the trigger from any where

Screenshot showing Box Collider becoming a trigger box

Screenshot showing assigning of Convai NPC to trigger component

Step 4: Assign your Convai NPC to Convai NPC field
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You can use this code block as a reference to invoke the trigger from anywhere

Screenshot showing ability to select your desired trigger

if(convaiNPC.TryGetComponent(out NarrativeDesignTrigger narrativeDesignTr
{
    //Optional message parameter if you want to send some message while in
    //the trigger 
    string message = "Player has collected enough resources";
    narrativeDesignTrigger.InvokeSelectedTrigger(message);
}

Invoke Trigger from any script
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Adding NPC to NPC Conversation
This guide will walk you through setting up the NPC to NPC conversation feature in

the Convai SDK.

1. Go to your Convai NPCs:

2. Enable Group NPC Controller:

3. Create or Find the Speech Bubble Prefab:

4. Attach Required Components:

Select the NPCs you want to include in the conversation.

Click on the Group NPC Controller  checkbox in the inspector panel.

Click Apply Changes  to add the group NPC controller script.

Create a new speech bubble prefab or use the one provided in the Prefabs
folder.

Step 1: Setting up Convai NPC
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5. Add Relevant Components:

1. Create an NPC To NPC Manager GameObject:

2. Add the NPC2NPC Conversation Manager Script:

3. Configure the NPC Group List:

Add the speech bubble prefab and the player transform (optional, defaults to

the main camera if not provided).

Set the conversation distance threshold variable (set it to zero to disable this

feature, meaning NPC to NPC conversations will always happen regardless of

the player’s distance).

Add components like lip sync, eye and head tracking, character blinking, etc.,

to the Convai NPC.

Add an empty GameObject and rename it to NPC to NPC Manager  (optional).

Attach the NPC2NPCConversationManager  script to the GameObject.

In the NPC Group List , click on the +  icon to add a new list element.

Add the NPCs you want to include in the group conversation.

Set the group discussion topic.

Step 2: Setting up NPC Manager
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4. Post configuration of NPCs

By following these steps you can set up and manage NPC to NPC conversations in

your Convai-powered application. For further customization and integration, refer to

the complete implementation code and adjust it as needed for your specific use

case.

Bring the NPCs close together

Play the to make sure everything is working as intended.
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Adding Scene Reference
and Point-At Crosshairs
You can point at Interactable Objects and Characters and ask your characters about

them.

To enable this, simply drag and drop the Convai Crosshair Canvas  prefab into the

scene.
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Utilities
Unity Plugin Utilities - Enhance development with Convai's tools and resources.
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Player Data Container
All the information that Convai SDK needs from the player to work properly

This is a scriptable object which is made automatically after you hit play in the

editor with Convai SDK installed and in a Scene where Convai Base Scene

Essentials Prefab is present

Default Player Name

You can provide a default name of your players.

Player Name

Current name of your player, out of the box if you use our settings panel, we keep it

updated automatically, if you are using some custom logic, it will be your

responsibility to keep it updated, as our transcript UI use this name to show it in UI 

Speaker ID

Speaker ID for the player. Please note that Speaker ID is directly linked with your

API key, so for each API key there should be a unique speaker ID associated with

it. We handle the creation of the Speaker ID when it's not found in the Player Prefs if

the Boolean is set to true.

Create Speaker ID If Not Found 
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This Boolean lets the SDK if it should create a unique Speaker ID for that Player

Name if it is not found in the Player Prefs.

It just makes the Player Name and Speaker ID fields empty.

Copies the data into system buffer so you can paste it anywhere for debugging

purpose

1. Load: Loads the Player Name and associated Speaker ID from the player Prefs

2. Save: Saves the Player Name and associated Speaker ID from the player Prefs

3. Delete: Deletes the Player Name and associated Speaker ID from the player

Prefs

Convai provides a pre-made component which you can add to any GameObject  to

make the PlayerDataContainer  work out of the box.

Choose an existing GameObject or create a new GameObject  in the scene and add

the ConvaiPlayerDataHandler  component to your chosen GameObject  and it

should start working

Buttons

Reset Data

Copy Data

Player Pref Settings Button

How to maintain the Player Data
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You can also create the required Scriptable Object by going to 

Assets > Convai > Resources  and right clicking in the project panel and

navigating to Create > Convai > Player Data  and name it ConvaiPlayerDataSO

Make sure you name the created Scriptable Object exactly ConvaiPlayerDataSO  as

our system looks for this exact name

Optional Step
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Long Term Memory
Learn how to enable character retain conversation history across multiple sessions

Long-Term Memory (LTM) enables the persistent storage of conversational history

with NPCs, allowing players to seamlessly continue interactions from where they

previously left off, even across multiple sessions. This feature significantly

enhances the realism of NPCs, aligning with our goal of creating more immersive

and lifelike characters within your game.

Prerequisite: Have a project with Convai SDK version 3.1.0 or higher. If you don't have

it, check this documentation 

Setting Up Unity Plugin

1. Select your Convai Character 

2. Add the Long-Term Memory Component onto your character

Steps to get LTM working
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3. Make sure that Long Term Memory is enabled for that character 

Long Term Memory should now be working for your character.

This component will enable or disable LTM right from the unity editor

Toggling Long Term Memory

1) Click the button provided in the component

Components of the LTM System

Convai Long Term Memory Component
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2) It will take some time to update, and after that the new status of the LTM should

be visible in the inspector.

Since enabling or disabling Long-Term Memory (LTM) for a character is a global action

that impacts all players interacting with that character, we strongly recommend against

toggling the LTM status at runtime. This functionality should be managed exclusively

by developers or designers through the editor to ensure consistent gameplay

experiences.

Grpc.Core.RpcException: Status(StatusCode=InvalidArgument, Detail="Cannot find

speaker with id: 99fbef96-5ecb-11ef-93ce-42010a7be011.")

If you encounter this error, ensure that the SpeakerID was created using the same

API key currently in use. If you're uncertain about the API key used, you can reset

the SpeakerID and PlayerName by accessing the ConvaiPlayerDataSO  file located

in Assets > Convai > Resources , allowing you to start the process anew.

Troubleshooting
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Managing sessionID Locally
Session ID Management - Manage unique session IDs for Convai Unity integration.

In a typical application integrating with the Convai API, maintaining a consistent

session ID across different sessions is crucial for providing a seamless user

experience. This documentation outlines the best practices for storing and

retrieving session IDs using Unity's PlayerPrefs , including detailed steps and

example scripts.

A session ID uniquely identifies a session between the client and the Convai server.

Storing the session ID locally ensures that the same session ID is used across

different sessions, which helps in maintaining context and continuity in interactions.

When initializing a session, if a session ID is not available locally, it should be

fetched from the server and then stored locally for future use. Here's how you can

achieve this:

1. Fetch and Store Session ID: When initializing a session, check if a session ID is

stored locally. If not, fetch a new session ID from the server and store it using 

PlayerPrefs .

Importance of Session IDs

Storing Session IDs
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When initializing your application, retrieve the stored session ID to ensure continuity

in user interactions.

public static async Task<string> InitializeSessionIDAsync(string character
{
    // Retrieve stored session ID if it exists
    string sessionID = PlayerPrefs.GetString(characterID, string.Empty);

    // If no session ID is stored, initialize a new one
    if (string.IsNullOrEmpty(sessionID))
    {
        sessionID = await ConvaiGRPCAPI.InitializeSessionIDAsync(character

        // Store the new session ID locally
        if (!string.IsNullOrEmpty(sessionID))
        {
            PlayerPrefs.SetString(characterID, sessionID);
            PlayerPrefs.Save();
        }
    }

    return sessionID;
}

private async void Start()
{
    // Initialize session ID on start
    string characterID = "YourCharacterID"; // Replace with your actual ch
    string sessionID = await InitializeSessionIDAsync("CharacterName", grp

    if (!string.IsNullOrEmpty(sessionID))
    {
        Debug.Log("Session ID initialized and stored: " + sessionID);
    }
    else
    {
        Debug.LogError("Failed to initialize session ID.");
    }
}

Retrieving Session IDs
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The following example class demonstrates how to manage session IDs using 

PlayerPrefs  in a Unity project:

Example Class for Session Management
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using System;
using System.Threading.Tasks;
using Convai.Scripts.Utils;
using Google.Protobuf;
using Grpc.Core;
using Service;
using UnityEngine;
using static Service.GetResponseRequest.Types;

public class SessionManager : MonoBehaviour
{
    public ConvaiService.ConvaiServiceClient grpcClient;

    private void Start()
    {
        // Initialize session ID on start
        InitializeSession("CharacterName", grpcClient, "YourCharacterID")
    }

    private async void InitializeSession(string characterName, ConvaiServi
    {
        string sessionID = await InitializeSessionIDAsync(characterName, c

        if (!string.IsNullOrEmpty(sessionID))
        {
            Debug.Log("Session ID initialized and stored: " + sessionID);
        }
        else
        {
            Debug.LogError("Failed to initialize session ID.");
        }
    }

    public static async Task<string> InitializeSessionIDAsync(string chara
    {
        string sessionID = PlayerPrefs.GetString(characterID, string.Empty

        if (string.IsNullOrEmpty(sessionID))
        {
            sessionID = await ConvaiGRPCAPI.InitializeSessionIDAsync(chara

            if (!string.IsNullOrEmpty(sessionID))
            {
                PlayerPrefs.SetString(characterID, sessionID);
                PlayerPrefs.Save();
            }
        }
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1. Initialize Session: Call InitializeSessionIDAsync  to check if a session ID is

stored. If not, fetch and store it.

2. Store Session ID: Use PlayerPrefs.SetString(characterID, sessionID)  to

store the session ID locally.

3. Retrieve Session ID: Use PlayerPrefs.GetString(characterID, string.Empty)
to retrieve the stored session ID.

4. Use Session ID: Pass the session ID to your Convai API calls to maintain session

continuity.

        return sessionID;
    }
}

Error Handling: Ensure proper error handling when fetching and storing session

IDs.

Security: Consider encrypting sensitive information stored in PlayerPrefs .

Performance: Use asynchronous methods to avoid blocking the main thread

when fetching session IDs.

Detailed Steps for Session Management

Best Practices
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Transcript UI System
Transcript UI System - Integrate transcript UI with Convai's Unity plugin.

The Dynamic UI system is a feature within the Convai Unity SDK that provides

developers a robust system for in-game communication. This feature allows for

displaying messages from characters and players and supports various UI

components for chat, Q&A sessions, subtitles, and custom UI types. This document

will guide you through the integration, usage, and creation of custom UI types of

the Dynamic UI feature in your Unity project.

To interact with the chat system, you need to reference the ConvaiChatUIHandler

in your scripts. You can find the Transcript UI prefab in the Prefabs folder. 

Overview

Usage

Accessing the Chat UI Handler
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Here's an example of how to find and assign the handler:

Once you have a reference to the ConvaiChatUIHandler , you can send messages

using the following methods:

Sending Player Text

To send text as the player:

To send text as a character:

private ConvaiChatUIHandler _convaiChatUIHandler;

private void OnEnable()
{
    // Find and assign the ConvaiChatUIHandler component in the scene
    _convaiChatUIHandler = ConvaiChatUIHandler.Instance;
    if (_convaiChatUIHandler != null) _convaiChatUIHandler.UpdateCharacter
}

_convaiChatUIHandler.SendPlayerText(input);

input : The string containing the player's message.

_convaiChatUIHandler.SendCharacterText(characterName, 
currentResponseAudio.AudioTranscript.Trim());

characterName : The name of the character sending the message.

currentResponseAudio.AudioTranscript : The transcript of the audio response

from the character, trimmed of any leading or trailing whitespace.

Sending Messages

Sending Character Text
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While the Dynamic UI system within the SDK provides several pre-built UI types,

you may want to create a custom UI that better fits the style and needs of your

game and it designed to be extensible, allowing developers to add their custom UI

types. This is achieved by inheriting from the ChatUIBase  class and implementing

the required methods. The ConvaiChatUIHandler  manages the different UI types

and provides a system to switch between them.

To create a custom UI type, follow these steps:

Create a new C# script in your Unity project and define your class to inherit from 

ChatUIBase . For example:

Implement the abstract methods from ChatUIBase . You must provide

implementations for Initialize , SendCharacterText , and SendPlayerText :

using Convai.Scripts.Utils;
using UnityEngine;

public class CustomChatUI : ChatUIBase
{
    // Implement the required methods from ChatUIBase here.
}

Adding Custom UI Types to the Dynamic
Chatbox

Creating a Custom UI Class

Step 1: Define Your Custom Class

Step 2: Implement Required Methods
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Add any additional functionality or customization options that your custom UI may

require.

To use your custom UI class within the dictionary ConvaiChatUIHandler , you need

to add it to the GetUIAppearances  dictionary. This involves creating a prefab for

your custom UI and assigning it in the ConvaiChatUIHandler .

Here's an example of how to do this:

1. Create a prefab for your custom UI and add your CustomChatUI  component to

it.

2. Assign the prefab to a public variable in the ConvaiChatUIHandler  script.

3. Modify the InitializeUIStrategies  method in the ConvaiChatUIHandler
script to include your custom UI type.

public override void Initialize(GameObject uiPrefab)1
{2
    // Instantiate and set up your custom UI prefab here.3
}4

5
public override void SendCharacterText(string charName, string 
text, Color characterTextColor)

6

{7
    // Handle sending character text to your custom UI here.8
}9

10
public override void SendPlayerText(string playerName, string text, 
Color playerTextColor)

11

{12
    Handle sending player text to your custom UI here.13
}14

Step 3: Add Custom Functionality

Step 4: Assign and Use Your Custom UI
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4. Ensure that your custom UI type is added to the UIType  enum:

[Tooltip (Prefab for the customChatUI.")]1
public GameObject customChatUIPrefab;2

3
private void InitializeUIStrategies()4
{5
    Existing UI types6
    InitializeUI(chatBoxPrefab, UIType.ChatBox);7
    InitializeUI(questionAnswerPrefab, UIType.QuestionAnswer);8
    InitializeUI(subtitlePrefab, UIType.Subtitle);9

10
    // Custom UI type11
    InitializeUI(customChatUIPrefab, UIType.Custom); // Make sure 
to define UIType.Custom in the UIType enum

12

}13
14

private void InitializeUI (GameObject uiPrefab, UIType uiType)15
{16
    // existing code...17

18
    Add your custom UI initialization here19
    if (uiType == UIType.Custom)20
    {21
        CustomChatUI customUIComponent = 
uiPrefab.GetComponent<CustomChatUI>();

22

        if (customUIComponent == null)23
        {24
            Debug.LogError("CustomChatUI component not found on 
prefab.");

25

            return;26
        }27

28
        customUIComponent.Initialize(uiPrefab);29
        GetUIAppearances[uiType] = customUIComponent;30
    }31
}32

public enum UIType
{
    ChatBox,
    QuestionAnswer,
    Subtitle,
    CustomUI // Your custom UI type
}
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5. Now you can set your custom UI type as the active UI from the Settings Panel 

Settings Panel.

By following these steps, you can integrate your custom UI type into the Dynamic

Chatbox system and switch between different UI types at runtime.
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Pre-built UI Prefabs
Convai UI Prefabs - Utilize ready-to-use UI elements for Convai integration.

We provide several UI options to display character and user's transcript out of the

box that players can use with the Convai Plugin. You can use and customize these

prefabs. 

The ConvaiNPC and ConvaiGRPCAPI scripts look for GameObjects with Convai

Chat UI Handler as a component, and send any transcripts to the script so that it

can be displayed on screen.

Prefab Name: Convai Transcript Canvas - Chat

Both the user's and the character's transcripts are displayed one after other in a

scrollable chat box.

Types of UI

ChatBox
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Prefab Name: Convai Transcript Canvas - Subtitle

The user and character transcripts are displayed in the bottom like subtitles.

Subtitle

Question-Answer
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Prefab Name: Convai Transcript Canvas - QA

The user's transcript is displayed in the top where as the character's transcript is

displayed in the bottom.

Prefab Name: Convai Transcript Canvas - Mobile Subtitle

Identical to #subtitle UI. Includes a button that can be pressed and held for the user

to speak. Ideal for portrait orientation of screen.

Mobile Optimised UI Styles
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Prefab Name: Convai Transcript Canvas - Mobile QA
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Prefab Name: Convai Transcript Canvas - Mobile Chat
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Convai Chat UI Handler Component
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SendCharacterTe

xt

A public function that sends a string of text to be displayed  as

character transcript along with the name of the character who said it.

SendUserText
A public function that sends a string of

text to be displayed  as user transcript.

Functions to Know
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Input Management
Input Management - Efficiently handle input for Convai's Unity plugin integration.

Make sure that Active Input Handling in 

"Project Settings > Player" is set to Both or Input System Package (New). 

Our recommendation is Both. This way, you can use both the new and old input

systems. Using the old input system can be faster when creating inputs for testing

purposes.

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 169/529

1. Double click on the "Controls" asset in your project tab. 

2. You can setup multiple control schemes for different devices here, currently we

have it for PC (Keyboard & Mouse) and Gamepad. For mobile, we have provided

joystick and buttons, which are mapped to Gamepad controls for functionality,

but you can directly add touchscreen and use its different features to trigger an

Input Action. You can also add your own control scheme if you want support for

a different device by clicking on "Add Control Scheme". 

How to Change the Talk Button or Any Input?
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3. Find the Input Action you want to change in the above window. If you want to

add a new Input Action, refer to the other section in documentation. In this case,

we selected "Talk Key Action" to change the talk button. Click on "T

[Keyboard]". In the Binding Properties window, click on the " T [Keyboard] "

button in the Path field.
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4. Press the " Listen " button in the top left of the opened window. If you prefer,

you can choose your desired input from the categories below.

6. Press the key you want to assign.

7. After assigning the desired key, you can see in the Inspector that the input for " 

Talk Key Action " has changed.

How to Add a New Input Action?
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1. First, open the " ConvaiInputManager.cs " script.

( " Convai / Scripts / Utils / ConvaiInputManager.cs " )

2. Create a variable of type InputAction in the field where other InputAction

variables are located. We'll create an Interaction Key Action for example.

public InputAction InteractionKeyAction;
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3. In the OnEnable method, you need to enable the InputAction you created.
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4. Now, let's create a method to access this InputAction.

The #if ENABLE_INPUT_SYSTEM preprocessor directive ensures that this #if

statement will function correctly when you select either ' Both ' or ' Input System

Package (New) ' in " Project Settings > Player > Active Input Handling "

If you select " Input Manager (Old) " for Active Input Handling, the #else statement

will work. Thus, in the #else section, we added the equivalent for the old input

system.

InteractionKeyAction.Enable();

public bool WasInteractionKeyPressed()
{
#if ENABLE_INPUT_SYSTEM
    return InteractionKeyAction.WasPressedThisFrame();
#else
    return Input.GetKeyDown(KeyCode.E);
#endif
}
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5. After applying the above steps, save by pressing " CTRL+S " Make sure you've

done everything correctly.

6. Return to Unity, click on ConvaiInputManager and in the Inspector, you can see

the added Input Action. To assign a key to this Input Action, click the " + "

button.
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7. In the opened window, click on the " Add Binding " button.

8. Click the " Listen " button in the opened window and press the key you want to

assign or choose the desired key from the categories.

9. After selecting the desired key, you can see the assigned key under your Input

Action in the Inspector.
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Notification System
Notification System - Implement notifications with Convai Unity plugin utilities.

The Convai plugin comes with default notifications, totaling four. Here they are:

Appears when you press the talk button but there is no active NPC nearby.

Appears if you release the talk button in less than 0.5 seconds.

Appears when the recorded audio input level is below the threshold.

Notifications

Not Close Enough to the Character

Talk Button Released Early

Microphone Issue Detected
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Appears when there is no internet connection upon launching the application.

Adding your custom notification is straightforward. 

Let's go through the steps to add a " CharacterStartedListening" notification as an

example.

1. Open the script "Convai/Scripts/Notification System/Notification Type.cs."  This

script stores Notification Types as enums. Give a name to your desired

Notification type and add it here.

Connection Problem

How to Add Your Own Notification?

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 180/529



2. Right-click on "Convai / Scripts / Notification System / Scriptable Objects" and

select "Create > Convai > Notification System > Notification" then create a

"Notification Scriptable Object".
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3. Name the created Notification Scriptable Object. Click on it, and fill in the fields

in the Inspector as desired.

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 182/529



4. Add the created Notification Scriptable Object to "Convai/Scripts/Notification

System/Scriptable Objects" under "Convai Default Notification Group" (details

of Notification Group here****).

5. Your Notification is now ready. The last step is to call this Notification from

where you need it. For example, if you created the " CharacterStartedTalking "

Notification, find the location where your character listens and write the code.
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6. Replace the parameter with the NotificationType you created.

(For our example, NotificationType.CharacterStartedListening)

7. Ensure that the Convai Notification System is present in your scene.

(accessible from "Convai/Prefabs/ Notification System")

All steps are complete, and you're ready to test!🙂✅

This Scriptable Object stores information about a Notification

To create a new Notification Scriptable Object, right-click anywhere in the Project

Window and select "Create > Convai > Notification System > Notification"

NotificationSystemHandler.Instance.NotificationRequest(NotificationType.Ch

Notification Type

Notification Icon

Notification Title

Notification Message

Notification Scriptable Object
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This Scriptable Object stores Notification Scriptable Objects as groups. When a

Notification is requested, it searches for the Notification using the specified

Notification Group in the Convai Notification System prefab's Notification System

Handler script. 

You can create different Notification groups based on your needs. Note: If your

referenced Notification Group does not have the Notification you want, that

Notification won't be called.

The Convai Default Notification Group has four Notifications, but you can add more

or create a new group with additional notifications.

Notification Group Scriptable Object
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Settings Panel
Settings Panel - Customize settings using Convai's Unity plugin utilities.

Settings Panel consists of two main sections.

On the PC platform, you can open the Settings Panel by pressing F10.

For mobile platforms, you need to press the Settings button in the UI designs.

Audio Settings

Interface Settings

Audio Settings

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 186/529



The Microphone Settings section is primarily for troubleshooting and testing the

microphone when using the Convai plugin.

In the Input section, you can view the microphones connected to your computer

and select the desired one.

In the Test Input field, you can record your voice using the selected microphone

in the Input section. After clicking Stop, you can listen to the recorded voice and

observe the sound levels.

Microphone Settings

Interface Settings

Appearance

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 187/529

The first setting that greets us here is the Appearance setting. 

In the Appearance section, you can switch between Transcript UI designs. 

There are three Transcript UI options: 

The second section in Interface Settings is the Display Name section. This section

allows you to change how the user's name appears in the Transcript UI.

The last section in Interface Settings is the Notifications Checkmark. 

Convai sometimes displays notifications on the screen to inform the user. If you

want to disable these notifications, you can click the checkbox here. ( If the box is

green, it's active. If empty, it's inactive ) 

For more information about notifications, you can refer to this link.

ChatBox 

QuestionAnswer

Subtitle

Upon selecting a UI from the dropdown menu, you can preview it briefly.

Display Name

Notifications Checkmark
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Building for supported platforms
With Convai's Unity SDK, you can build your favorite application for several

platforms, including Windows, MacOS and Android. Currently, we also support

these platforms:

1. iOS/iPadOS

2. Virtual Reality (Occulus)

3. Augmented Reality (Android/iOS)

4. WebGL

5. Universal macOS applications
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Building for iOS/iPadOS
This guide will walk you through the process of installing Convai-powered Unity

applications on iOS and iPadOS devices.

Before you begin, make sure you have the following:

1. Open your Convai-powered Unity project.

2. Ensure you have the latest version of the Convai Unity SDK imported and setup

into your project.

Unity 2022.3 or later

Xcode (latest version recommended)

Apple Developer account

Project with Convai's Unity SDK integrated and running properly

MacBook for building and deploying to iOS/iPadOS

Prerequisites

Step 1: Prepare Your Unity Project
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1. In Unity, go to File  → Build Settings .

2. Select iOS  as the target platform.

3. Click Switch Platform  if it's not already selected.

4. Check the Development Build  option for testing purposes.

Unity project with Convai SDK imported

Step 2: Configure Build Settings
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If you wish to add a few required files manually, follow step 3. If you want it to be done

automatically, jump to step 4

1. Create a new file named link.xml  in your project's Assets  folder.

Unity Build Settings window with iOS selected and Development Build checked

Step 3: Manually add Required Files

Add link.xml
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2. Add the following content to the file:

This file prevents potential FileNotFoundException  errors related to the 

libgrpc_csharp_ext.x64.dylib  file.

1. Create a new C# script in Assets/Convai/Scripts  named iOSBuild.cs .

2. Add the following content to the script:

<linker>
  <assembly fullname="UnityEngine">
    <type fullname="UnityEngine.Application" preserve="fields">
      <property name="platform"/>
    </type>
  </assembly>
</linker>

Unity project view showing the link.xml file in the Assets folder

Add BuildIos.cs Script
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1. Go to Convai -> Custom Package Installer

2. Click on Install iOS Build Package

3. Attach the  script iOSBuild.cs  to any GameObject in your scene.

#if UNITY_EDITOR && UNITY_IOS
using System.IO;
using UnityEditor;
using UnityEditor.Callbacks;
using UnityEditor.iOS.Xcode;
using UnityEngine;

public class iOSBuild : MonoBehaviour
{
    [PostProcessBuild]
    public static void OnPostProcessBuild(BuildTarget target, string path
    {
        string projectPath = PBXProject.GetPBXProjectPath(path);
        PBXProject project = new PBXProject();
        project.ReadFromString(File.ReadAllText(projectPath));
#if UNITY_2019_3_OR_NEWER
        string targetGuid = project.GetUnityFrameworkTargetGuid();
#else
        string targetGuid = project.TargetGuidByName(PBXProject.GetUnityTa
#endif
        project.AddFrameworkToProject(targetGuid, "libz.tbd", false);
        project.SetBuildProperty(targetGuid, "ENABLE_BITCODE", "NO");
        File.WriteAllText(projectPath, project.WriteToString());
    }
}
#endif

Step 4: Install required gRPC dlls for iOS:
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1. In Unity, go to File  → Build Settings .

2. Click Build  and choose a location to save your Xcode project.

3. Wait for Unity to generate the Xcode project.

Step 5: Build the Xcode Project
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1. Open the generated Xcode project.

2. In Xcode, select your project in the navigator.

3. Select your target under the "TARGETS" section.

4. Go to the "Signing & Capabilities" tab.

5. Ensure that "Automatically manage signing" is checked.

6. Select your Team from the dropdown (you need an Apple Developer account for

this).

7. If needed, change the Bundle Identifier to a unique string.

1. Connect your iOS device to your Mac.

Xcode window showing the Signing & Capabilities tab with Team and Bundle Identifier fields

highlighted

Step 6: Configure and Build in Xcode

Step 7: Build and Run
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2. In Xcode, select your connected device as the build target.

3. Click the "Play" button or press Cmd + R  to build and run the app on your

device.

Xcode toolbar showing the connected device selected and the "Play" button highlighted

If you encounter any build errors, ensure all the steps above have been followed

correctly.

Check that your Apple Developer account has the necessary provisioning

profiles and certificates.

If you face any GRPC-related issues, verify that the libgrpc_csharp_ext.a  and 

libgrpc.a  files are correctly placed in the 

Assets/Convai/Plugins/gRPC/Grpc.Core/runtime/ios  folder.

Troubleshooting
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You should now have successfully installed your Convai-powered Unity app on

your iOS or iPadOS device. If you encounter any issues or need further assistance,

please visit our discord channel or contact Convai support.

Conclusion
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Building for WebGL
This guide will help you integrate Convai's WebGL capabilities into your Unity

projects, enabling you to bring to life AI characters with human-like conversational

abilities.

Convai's Unity WebGL SDK is designed to complement the standalone application

capabilities of our Unity Asset Store version. With this specialized SDK, you can

build and deploy interactive WebGL applications that leverage Convai's advanced

conversation pipeline. Please see the instructions below or check out our latest

tutorial video on YouTube.

Smart AI NPCs For Virtual Worlds Running in Your Web Browser | CoSmart AI NPCs For Virtual Worlds Running in Your Web Browser | Co……

Description

Getting Started

Download the SDK and Demos
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Download the WebGL version of the Convai Unity SDK here.

Download the Complete  WebGL Demo here.

Try out the Demo on itch.io here.

Please ensure that Git is installed on your computer prior to proceeding.

Download Git from here.

Follow the Import and Setup Instructions from Import and Setup (nightly) and 

Setting Up Unity Plugin. 

When attempting to play the scene in the Unity Editor, you may encounter the

following error:

This error occurs because the WebGL SDK cannot be tested directly within the

Unity Editor. To test your WebGL application, you must create a development build.

WebGL SDK does not run in Unity Editor. Please build and run in WebGL.

Prerequisites

Import and Setup Instructions

WebGL Incompatibility with Unity Editor

Switching to WebGL
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Now, your Unity setup is done, let's setup WebGL

Head on over to File  → Build Settings , then:

1. Click on WebGL .

2. Check the Development Build  box.

3. Select Switch Platform.

Patience, remember? This shift takes a bit.

After the platform is switched to WebGL, click on Player Settings .This is where

the fun begins:
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Once the platform conversion is complete,

1. Open the file Player Settings .

2. Navigate to the page WebGL settings .

3. Under the Resolution and Presentation  tab, select the Convai PWA Template .

After the reloads is completed, check if the settings have changed. then, close all

the open menus and follow these steps :

Configuring Player Settings

Importing Characters and Building the Scene
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1. Double-click the Convai folder  and go to scenes.

2. Open the Convey Demo WebGL  scene.

3. Head to Convai's website, grab your API key, and input it back in Unity via 

Convai  → Convai Setup .

4. Now, head again to the Convai’s website and grab your favourite character’s id

and paste it to Convai  → Character Importer .

Remember, Unity's editor won't let us test WebGL directly. But fear not, there's a 

Build and Run option:
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1. Go back to File  → Build Settings .

2. Click Add Open Scenes  and then Build and Run .

Choose a folder for the build output, make a new one if needed, and name it

"WebGL."
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The First build may take some time.

For subsequent builds and runs, use the Unity shortcut key Ctrl + B.

The first build is the longest, so feel free to stretch a bit – but don't venture too far.

Soon, you'll greet our demo character, Amelia, or any other character you brought

into your digital oasis. Just give your Microphone permissions and here you go!

Now the magic happens. Press and hold 'T' to chat with your carefully cultivated

character. Or click on the text box to type out a question. And for the attention to

detail – press F10 to access the settings panel where you can change your name

and the UI style to your liking.

Feeling accomplished? You should! You now have a successfully working WebGL

build in your browser. Curious developers can take a step further by downloading

the project files from GitHub, available for all who desire to peek behind the curtain.

Engaging with your Convai AI NPCs
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When you are ready with your production build, just uncheck the Development Build

field in the Build Settings before publishing
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Building for VR
Building for VR - Unity Plugin Guide for VR development with Convai.

If you want to make your Convai Plugin compatible with VR, you can do so using the

automatic or manual process. Please see the instructions below or check out our 

latest tutorial video on YouTube.

Recommended for new projects.

The following processes will be performed:

Unleash the Power of Convai AI NPCs in Your Unity VR Game

Unleash the Power of Convai AI NPCs in Your Unity VR Game | TutorialUnleash the Power of Convai AI NPCs in Your Unity VR Game | Tutorial

Universal Render Pipeline (URP)

OpenXR Plugin

VR Installation

Method 1 : Automatic Setup

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 207/529

If these packages are not present, they will be installed.

If the target build platform is not Android, it will be switched to Android.

Make sure to download the Android platform support from Unity Hub for your project's

version.

1. Click on " Convai / Convai Custom Package Installer / Install VR Package "

2. Confirm the changes and processes to be made. If you agree, the process will

start.                     Click " Yes, Proceed " and the process will begin. You'll see

logs in the console.

3. If you encounter an error like " Failed to Resolve Packages " don't worry. The

process will continue and the error will be resolved automatically after the

package installations are complete.

XR Interaction Toolkit

Convai Custom VR Package

Convai URP Converter
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4. Open the " Convai / Scenes / Convai Demo - VR " demo scene. If the TMP

Importer window appears, click " Import TMP Essentials " to install

TextMeshPro for UI text objects.

Alternatively, you can use the " Window / TextMeshPro / Import TMP Essential

Resources " to install it.
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5. Build your project by going to " File /Build Settings / Build " Ensure that the " 

Convai Demo - VR " scene is included in the Scenes in Build section.

Now everything is ready for testing. 🙂✅

Ensure you've set up your API Key. ( Convai / Convai Setup )

Ensure you have the following packages installed in your project:

1. Double-click on " Convai / Convai Custom Unity Packages /

ConvaiVRUpgrader.unitypackage "

OpenXR or Oculus XR

XR Interaction Toolkit

URP (Universal Render Pipeline)

Method 2 : Manual Setup 
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2. You'll see a warning that the settings will overwrite your project settings. You

can either allow it by clicking " Import " or create a temporary project by clicking

" Switch Project "

3. In the Import Unity Package window, review the assets to be imported and click

" Next "

4. In this window, select the project settings you want to import and complete the

installation by clicking " Import ".
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5. Open the " Convai / Scenes/ Convai Demo - VR " demo scene. If the TMP

Importer window appears, click " Import TMP Essentials " to install

TextMeshPro for UI text objects.

6. If you see 3D objects in pink, it's a shader issue. If you're using URP, convert the

materials to URP by double-clicking on " Convai / Convai Custom Unity

Packages / ConvaiURPConverter " and importing all assets in the window that

appears.
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7. Build your project by going to " File / Build Settings / Build " Ensure that the " 

Convai Demo - VR " scene is included in the Scenes in Build section.

Now everything is ready for testing. 🙂✅

Ensure you've set up your API Key (Convai/Convai Setup).

Convai Default VR Controller Scheme
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Building for AR
Building for AR - Unity Plugin Guide for AR development with Convai.

If you want to make your Convai Plugin compatible with AR, you can do so in two

ways. Please see the instructions below or check out our latest tutorial video on

YouTube.

Recommended for new projects.

The following processes will be performed:

Location-aware AI characters in Augmented Reality (AR) | Convai UniLocation-aware AI characters in Augmented Reality (AR) | Convai Uni……

Universal Render Pipeline (URP)

ARCore Plugin

AR Installation

Method 1 : Automatic Setup
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If these packages are not present, they will be installed.

If the target build platform is not Android, it will be switched to Android.

Make sure to download the Android platform support from Unity Hub for your project's

version.

1. Click on " Convai / Convai Custom Package Installer / Install AR Package "

2. Confirm the changes and processes to be made. If you agree, the process will

start.                     Click " Yes, Proceed " and the process will begin. You'll see

logs in the console.

Convai Custom AR Package

Convai URP Converter
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3. If you encounter an error like "Failed to Resolve Packages," don't worry. The

process will continue, and the error will be resolved automatically after the

package installations are complete.

4. Open the " Convai / Scenes / Convai Demo - AR " demo scene. If the TMP

Importer window appears ( It will appear if TMP Essentials is not installed in your

project ), click " Import TMP Essentials " to install TextMeshPro Essentials for UI

text objects.
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Alternatively, you can use the " Window / TextMeshPro / Import TMP Essential

Resources " to install it.

5. After importing TMP Essentials, you can remove the empty GameObject in your

scene that triggers the Prompt window to appear.

6. Build your project by going to " File / Build Settings / Build  " Ensure that the " 

Convai Demo - AR " scene is included in the Scenes in Build section.
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Ensure you've set up your API Key. ( Convai / Convai Setup )

Now everything is ready for testing. 🙂✅

Ensure you have the following packages installed in your project:

ARCore

URP (Universal Render Pipeline) - Recommended for optimization,

though not mandatory

Method 2 : Manual Setup 
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1. Double-click on " Convai / Convai Custom Unity Packages /

ConvaiVRUpgrader.unitypackage "

2. You'll see a warning that the settings will overwrite your project settings. You

can either allow it by clicking " Import " or create a temporary project by clicking

" Switch Project "

3. In the Import Unity Package window, review the assets to be imported and click

" Next "
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4. Select all settings to be changed in the Project Settings and complete the

installation by clicking    " Import "
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5. Open the " Convai / Scenes / Convai Demo - AR " demo scene. If the TMP

Importer window appears ( It will appear if TMP Essentials is not installed in your

project ), click " Import TMP Essentials " to install TextMeshPro Essentials for UI

text objects.
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Alternatively, you can use the " Window / TextMeshPro / Import TMP Essential

Resources " to install it.

6. After importing TMP Essentials, you can remove the empty GameObject in your

scene that triggers the Prompt window to appear.

7. If you see 3D objects in pink, it's a shader issue. If you're using URP, convert the

materials to URP by double-clicking on " Convai / Convai Custom Unity

Packages / ConvaiURPConverter " and importing all assets in the window that

appears.

8. Ensure you've set up your API Key ( Convai / Convai Setup ).

9. Build your project by going to " File / Build Settings / Build " Ensure that the " 

Convai Demo - AR " scene is included in the Scenes in Build section.
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Now everything is ready for testing. 🙂✅

If you've created a Ready Player Me character on convai.com playground and want

to add it to your AR project, follow these steps:

1. Right-click on the " Convai / ConvaiAR / Prefabs / Convai NPC AR Base Empty

Character " prefab.

2. Click on " Create / Prefab Variant "

How to Add and Adjust Size Of My Own
Character?
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3. You'll see a prefab variant created for " Convai NPC AR Base Empty Character "

4. Double-click on this prefab variant.

5. In the Hierarchy section, add your imported character as a child to this prefab

variant.
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Use the " Importing RPM Characters " guide to add your character to your project.

6. After adding your character, click on your character.

7. In the Inspector, adjust the Scale settings as needed. To prevent your character

from moving with animation while talking, disable the " Apply Root Motion "

option in the Animator.             

8. After these steps, save your prefab variant by pressing CTRL + S.

9. Open the " Convai / Scenes / Convai Demo - AR " scene.

10. Click on the " Convai AR Player " object under " ConvaiAR Base Scene "
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11. In the Inspector, under the " Convai Character Spawner " component, add

your prefab variant to the Character Prefab field.

Now, everything is ready to test your character in the AR environment!🙂✅

Creating this prefab variant is to prevent automatic scaling ( 1,1,1 ) of your prefab when

instantiated in the AR environment. 

To avoid issues with scale adjustments, we added our character as a child to an empty

parent object. For convenience, we created an empty prefab variant.
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Building for macOS Universal apps

When building Unity projects for macOS, developers may encounter issues with

microphone permissions, particularly when targeting both Intel and Apple Silicon

Macs. This document outlines the problem, symptoms, causes, and solutions to

help ensure successful access to the microphone across different Mac

architectures.

Some users have reported that while building macOS universal apps, Apple Silicon

Macs handle microphone permissions without issue, while Intel Macs may fail to

access the microphone due to differences in architecture. This can result in a lack

of microphone response, DLL not found Exceptions, error messages, potential

application crashes, or no audio input being detected.

The issue stems from the grpc_csharp_ext.bundle , which is crucial for networking

in Unity projects. There are separate versions of this DLL for Intel and Apple Silicon

architectures, and they cannot be easily merged or applied universally. The grpc

library currently lacks dedicated support for resolving these dll issues in Unity.

For Intel Macs: Use Standalone builds targeted specifically for the Intel

architecture to ensure compatibility.

Overview

Problem Description

Cause

Solutions

Standalone Build Settings
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After completing a Universal build on an Intel Mac, you must manually update the 

grpc_csharp_ext.bundle  to ensure proper functionality. Follow these steps:

1. Locate the .app  file generated by the build process.

For Apple Silicon Macs: Prefer Standalone builds for the ARM64 framework for

optimal performance, although Universal builds are also an option.

New Procedure for Universal Builds from Intel Macs
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2. Right-click on the .app  file and select "Show Package Contents."

3. Navigate to the Contents/Plugins  folder within the package.
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4. Replace the contents of this folder with the components from the provided

plugin folder (link to plugin folder).
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Important: The grpc_csharp_ext.bundle  may not be included correctly in the final

build when built from an Intel Mac. Always verify that the Plugins  folder in the

build contains the correct DLLs. If there is any confusion or the DLLs are missing,

replace or add the contents of the Plugins  folder with the one provided by us.

Building for macOS requires careful consideration of the distinct Intel and Apple

Silicon architectures. The current best practice is to use Standalone build settings

tailored to the specific architecture of the target Mac. As we progress, we will have

a more integrated solution for managing DLLs that will simplify the development

process for universal macOS applications.

Conclusion
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Changelogs
Convai Unity Plugin Changelogs - Stay updated with the latest changes.

Released: Jun 21, 2024

Released: Jun 13, 2024

1. Added Narrative Design-related files and trigger narrative section function.

2. Refactored Narrative Design API, created new behavior trees for movement and

added section change events.

Fix macOS TMP UGUI render issue in demo scene

Prefab missing animator

Updated ActiveNPC layer check logic

Implemented NPC2NPC conversation flow system.

Added handling for conversation interruptions and restarts.

Enhanced conversation history tracking and flow management.

Version 3.0.1 current

Bug Fixes:

Version 3.0.0

What's Changed

NPC2NPC System

Narrative Design
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3. Folder Restructuring

4. Gender-Based Animator: Added gender-based Animator controller

5. Feedback System

6. Convai Custom Packages: Updated Convai Custom Package Installer and

added iOS DLL Downloader

7. Scene Perception: Added feature to allow players to point at game objects and

talk about them

1. Texture and Material Compression

2. UI Updates

3. System Improvements

4. Microphone Manager: Updated Microphone Manager to a singleton class

5. API Key Access: Simplified API Key access

Complete folder and scripts folder restructure

Implemented a feedback system with thumb icons and animations

Updated Transcript UI Prefabs with feedback buttons

Compressed Amelia and other images (POT and Crunch)

Updated image names and removed unused image assets

Updated UI prefabs, including Transcript UI, Mobile UI, and Mobile QA UI

Transcript UIs and text updated

Updated logos and logo paths

Refactored Lipsync system with added teeth support and implemented facial

expression proto files

Updated ConvaiURPConverterPackage, burst and TMPro packages; Convai

Custom Package Installer/Exporter

Updated NavMesh and NPC2NPC character rotation

Added new demo scene and RPM characters

Updated various demo scenes for consistency

Improvements
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6. Convai Scene Template: Created new scene template and dynamic input

system assigner

7. Demo Scenes

8. Lipsync Overhaul

9. Input System

1. Transcript UI Bug Fixes: Fixed bugs and improved system for Transcript UI

character list

2. Microphone Permission: Fixed Android and iOS microphone permission issues

1. VR Support: Implement Virtual Reality features to create a fully immersive

experience with the press of a button. 

2. AR Support: Integrate Augmented Reality capabilities, allowing characters and

environments to interact with you in the real world with the press of a button. 

3. Settings Panel: Introduce a comprehensive settings panel that allows users to

customize their experience.

Added NPC2NPC demo scene

Added Narrative Design demo scene

Added new demo scene with all features encompassed

"Convai Essentials" prefab for desktop and mobile

Overhauled lipsync system, added AR-Kit and Reallusion character support

Updated version and added various improvements to frame processing

Added new input system pragma checks and Convai Character Layer

Simplified Input Manager and ensured future-proofing

Bug Fixes

Version 2.1.0

What's Changed

26/08/2024, 15:25 Documentation

https://open.gitbook.com/~space/EtUJA212Zc1S9ACc8T4l/~changes/FMz29m3j3FhHZk39fiQn/~gitbook/pdf?back=false&limit=200 235/529

4. Microphone Test System: Incorporate a microphone testing feature to ensure

optimal audio input quality. 

5. Notification System: Implement a robust notification system to inform users of

in-game events - specifically microphone-based issues.

6. Input Manager: Develop a custom input management system that supports

various input devices such as keyboards, gamepads, and touchscreens using

Unity's new Input System. 

1. Fixed: Head Tracking Doesn’t Work Without Action Component issue fixed.

2. Improvement: Added support for a customizable and dynamic Chatbox.

3. Improvement: Improved Lip-Sync Smoothing and audio-visual synchronization.

4. Improvement: Implement Action Events and Event Callbacks.

5. Improvement: Improved Logging System.

6. Improvement: Added ability to interrupt Character Response with Voice

Interruption.

7. Improvement: Improved mobile platform transcription UI.

1. Lip-sync: Integrate off-the-shelf Lip-sync for Reallusion and Oculus-based

Characters.

2. Text-in Voice-out: Chat with the character using text.

3. Character Importer: Import Ready Player Me characters created on the Convai

Playground.

4. Feature Control System: Enable Convai features as needed through the Convai

NPC component.

5. Logging System: Have better control over what Convai information you see on

the debug console.

Bugs and Improvement

Version 2.0.0

What's Changed
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6. Enhanced player controller: Automatically triggers the characters when you

focus on them and then deactivates them when your focus has shifted.

7. URP Upgrader: Upgrade the Render Pipeline to Universal Render Pipeline with

the URP Upgrader package (present in the Convai Folder).

8. UI Improvements: Improved user experience with automatically fading UI

canvas.

1. Fixed: Unlocking the cursor will still cause the first-person camera to move

around.

2. Fixed: Exiting play mode before the character is done speaking will cause Unity

to crash or not complete compilation.

3. Fixed: Extra space between multiple chunks of text in the UI Text Fields.

4. Fixed: Actions crashing the Android scene.

5. Fixed: Empty responses from the server will not crash the game but only throw

an error.

6. Improvement: Smoothened Blinking.

7. Improvement: Smoothened Gaze-Following-based Neck movement.

8. Improvement: Plugin structure reorganization.

Bugs and Improvement
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